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Form Templates 

The Form Template allows you to create complex forms for output purposes. You can easily 

add fields, frames, grids and other objects to create output documents with any information 

from within People-Trak. You have the option of selecting a PDF form as a background. 

Then, using a drag and drop tool, you can position the fields and other objects at the 

appropriate location on the form. When the custom form is complete, you can create 

documents based on the custom form by using the Forms option on the Documents menu. A 

special option in this feature enables you to decide if you wish to actually print the form 

background, if there is one. If you have preprinted forms such as numbered forms, you can 

use the imported form to layout and maintain the form. However, at print time, you can cause 

the data only to be printed, thus placing the appropriate data at the appropriate locations on 

your form without the form background. You will need to have your pre-printed forms in the 

printer and should have already had the custom form’s Print Image check box cleared before 

generating the form. 

When the Form Templates option is selected on the Templates menu, the screen shown below 

is displayed.  

 

Form Details 

Form Details include naming the form template, assigning it to a category.and defining the 

paper size, page width, page height and margins. 

Note: On full page forms, this Margins should be set to 0. 
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Objects 

The following are object types available to use on a form template. Descriptions for each 

object ype are also defined.  

Border                                
Used for placing a border around the form. When selected, the Form Name is defaulted as the 

Caption to use for the form but can be overwritten 

Heading 1     
Used to place a heading on the form with a colored background. In the default People-Trak 

style, this heading is in 14-point text with a background of the dark color associated with the 

selected color scheme. 

Heading 2     
Used to place a heading on the form with a colored background. In the default People-Trak 

style, this heading is in 12-point text with a background of the dark color associated with the 

selected color scheme. 

Heading 3    
 Used to place a heading on the form with a transparent background. In the default People-

Trak style, this heading is in 14-point text. 

Heading 4    
 Used to place a heading on the form with a transparent background. In the default People-

Trak style, this heading is in 12-point text. 

Field     
Used for placing actual fields on the form. 

Frame     
Used to place and name a frame around fields in order to group them on the form. Field 

object rows that follow the Frame object row will be placed in the frame. When a grid object 

is selected, fields from that grid are defaulted as field object rows that are displayed vertically 

inside the frame. 

Grid     
Used to place a grid on the form. Field object rows that follow the Grid object row will be 

placed in the grid. When a grid is added and you select the grid name in the Object Name 

field, all fields in that grid are automatically added in the rows that follow the grid. You can 

then choose to delete one or more of the fields and/or rearrange the fields. 

Note: You cannot mix fields from different grids in one grid on the custom screen. 

Label    
 Used to place non-formatted label text on the form in order to provide directions or added 

information. This object is edited with the Simple Editor. 

Line    
 Used to place a line on the form. 
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Picture   
  Used to place a picture on the form. 

Defining and Updating Object Properties 

You can update an object’s properties in either the main Form Templates screen or preview 

mode. On the main screen, highlight the object in the grid and then click the Properties 

button. In preview mode, select the object and then press F1. Both of these methods display 

the Object Properties screen for the selected object. Each object type has its own unique 

Object Properties screen with the object properties that pertain to that object.  

The following are field descriptions for all fields that can be on an Object Properties screen. 

The actual name of the field will vary slightly based upon the object properties screen on 

which it is being displayed. Several of these fields are also available on the main Form 

Templates screen.   

Object Type  
The type of object. This field is for display only. 

Object Name  
The name of the object. This field is only used with the Field and Grid object types and is 

display only because the object names can only be changed on the main Custom Forms 

screen. 

Object Caption  
The caption to display for the object on the screen.  

Note: The following Left, Top, Width and Height fields are in pixels. 

Left  
Allows you to move the object’s location horizontally on the screen. The reference point for 

this value is the left-most side of the object. 

Top  
Allows you to edit the object’s location vertically on the screen. The reference point for this 

value is the top side of the object. 

Width  
Allows you to adjust the width of the object. When you increase the width, the right side of 

the object will move to the right. When you decrease the width, the right side of the object 

will move to the left. 

Height  
Allows you to adjust the height of object. When you increase the height, the bottom of the 

object will move downward. When you decrease the height, the bottom of the object will 

move upward. 

Alignment  
For a Field object, this is the alignment of data in the field. For all other objects, this is the 

alignment of the object’s caption. This field is supported by the Select Alignment popup. The 

alignment of the Field object’s caption is set in the Field Settings frame that is unique to only 

fields. 
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Row Modifier  
For a Field object, this is the row modifier of the field and is supported by the Select Row 

Modifier popup. For a Grid object, this is the number of rows in the grid, including the 

caption row. This field is not used with the other object types. 

Note: The Select Row Modifier popup screen shows codes 1-10, but higher row numbers can 

be manually entered as well. The popup also allows you to use “+” to access the last row on 

the grid, New 1 to insert a new top row and New + to insert a new bottom row. 

Field Modifier 
 For a Field object, this is the modifier that determines which part of the field is to be 

included on the form. Field modifiers can only be used with date and currency fields. This 

field is supported by the Select Field Modifier popup. If you try to select a field modifier for 

other field types, a message will appear stating that there are no valid modifiers. 

Field Settings 

The Field Settings frame and its settings are only applicable for Field objects and are only 

shown when editing the properties of a Field object.  

 

Note: The following Caption Left, Caption Top and Caption Width fields are in pixels. 

Caption Left  
Allows you to adjust the location of the field’s caption horizontally. The reference point for 

this value is the left side of the caption. 

Caption Top  
Allows you to adjust the position of the field’s caption vertically. The reference point for this 

value is the top side of the caption. 

Caption Width  
Allows you to adjust the width of the field’s caption. The caption will expand to the right 

when edited. 

Caption Alignment  
The alignment of the field’s caption. This field is supported by the Select Alignment popup. 

Using a Background Form  

Selecting a Background Form  
The Select Form button allows you to select the background PDF form for the form. The 

Select File popup supports this field and allows you to select a PDF file. 

Note: Only PDF forms can be selected. Contact your Support Representative if you need 

assistance getting a form into PDF format. 

Clearing a Background Form  
The Clear Form button allows you to clear the background PDF form from your form. 

Print Form  
A check box that allows you to specify whether or not the background form should be printed 

when printing the forms. Select this check box if you want to print the background form when 
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printing the forms. Clear the check box if you do not want to print the background form. If 

you are not using pre-printed forms, you would want to print the background form. If you are 

using pre-printed forms, you would not want to print the background form. 

Using Preview Mode 

The Preview feature allows you to easily place the selected objects on your form template. 

Preview mode is accessed from the main Form Templates screen by clicking the Preview 

button.  

When you enter preview mode for a form template, the Custom Form Editor screen is 

displayed and has a list of objects in the Object dropdown and the custom form on the right. 

A sample Custom Form Editor screen is shown below.  

 

There are several ways to edit the layout of your screen using preview mode. The details of 

every object on your screen can be edited. This section covers how to select and edit objects 

in preview mode.  

Selecting Objects 

You can select a single object by doing one of the following: 

 Select the object name in the Object dropdown. 

 Click the object itself on the screen on the right. 

 

You can select multiple objects by doing one of the following: 

 Hold down the CTRL key while selecting the individual objects. 

 Using the mouse, right-click on a field object. This will select both the Field and its 

Caption 

 Select a point to the upper left of the first desired object.  Hold down the shift key while 

pressing the left button on the mouse.  While doing so, drag the provided frame from the 

upper left starting position until all desired objects are within the frame (i.e. lassoed).  
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Then release the key and mouse.  This will select all the “lassoed” objects, just as if they 

were selected individually. 

Editing Objects 

After objects have been selected, there are several different ways to edit them. They are: 

 Move or size the object(s) using the mouse. 

 Move or size the object(s) using key combinations. 

 Move or size the objects using the alignment tools on the Format menu and Tool Bar. 

(This is only available when multiple objects have been selected.) 

 Edit object properties using the F1 key. 

(If multiple objects have been selected, the first object selected is edited.) 

 Aligning objects to the left and right margins of the screen using the ‘snap to edge’ 

feature 

 

Each of these methods is described below. 

Mouse 

The most common way to edit objects is to simply click-and-drag an object to the position or 

size you’d like. When you first click on an object to select it, you will see the object 

highlighted in red with red squares in each of the corners and on the sides.  

If you move the cursor to anywhere inside the object, the cursor will turn to two crossed lines 

with arrows pointing in four directions. An example of this is shown below: 

 

 

When the cursor looks like the above example, you can drag and drop the object to any 

location you desire.  

If you move the cursor to one of the red squares around the outside of the object, the cursor 

will turn to a line with arrows on either end. This line will either be vertical, horizontal or 

diagonal depending on which red square you are hovering over. It is indicating what direction 

the object will be sized. For example, the following example shows that the object will be 

sized vertically. 

 

When the cursor looks like the above example (or one of the other two direction lines), you 

can drag the object to be the size you desire and then release. 

Note: The cursor will vary based on the operating system being used. For example, the 

cursors shown above are in black, whereas these cursors are white outlined in black in the 

Vista operating system. 

Key Combinations 

After an object has been selected, SHIFT + ARROW keys will change the size of the object, 

while CTRL + ARROW keys will move the object. These hot keys are much more precise. It 

is best to move the object to the general area and size using the click-and-drag procedure, and 

then specify the location and size using the hot keys.  

Alignment Tools 

There are several alignment tools available in preview mode. These tools are found both on 

the Format menu and on the Tool Bar. These tools are only available after you have two or 

more objects selected. The first object selected is the controlling object. The subsequent 



Workbook 

 

 Form Templates     7 
 

objects selected will be aligned to the controlling object. A description of each tool is given 

below.   

 Align to Left  

 Align to Right  

 Align Spacing  

 Align Height  

 Align Width  

 Align to Top  

 Align to Bottom  

 

Align to Left aligns objects to the left side of the controlling object. Align to Right aligns 

objects to the right side of the controlling object. Align Spacing sets spacing between the 

objects to be the same as the spacing between the controlling object and the second object 

selected. Align Height sets height of the objects to be the same as the controlling object. 

Align Width sets width of the objects to be the same as the controlling object. Align to Top 

aligns objects to the top of the controlling object. Align to Botton aligns objects to the bottom 

of the controlling object. 

Snap to Edge 

If you would like to align an object, such as a grid, within the left and right margins of your 

form, the snap to edge feature provides a means for doing so. First, place your object in the 

desired area of the form, close to the edge. Using either keystrokes or your mouse, move the 

object towards the left or right margins of your form. Once the object is within 6 pixels from 

the edge of the form, it will automatically move or ‘snap’ to the edge that you moved it 

towards. 

Note: Please be aware that this feature cannot be turned off. When moving objects within 

your custom form, if the object is moved close enough to the left and right edges, it will 

‘snap’ and line up with the margin. 

Saving and Restoring 

When you are doing a lot of work in preview mode, we recommend that you save your work 

periodically using the Save option on the File menu.  

Use in Form Documents 

A custom form is used in a form document by selecting the form in the Form Name field of 

the Forms screen, which is accessed from the Forms option on the Documents menu.  

The Forms screen uses a two-tab screen. The Specification tab is used to define the 

specification. The Query tab is the standard query tab that is used to determine the records for 

which forms are to be produced. 

Specification Tab 
The Specification tab is used to assign the form document to categories, specify the form to 

use and set up sorting for the form document. 
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Document Name A unique name for the form specification. This name is used when retrieving the form 

document. 

Explorer 

Category 

The Explorer category into which the form document is to be placed. When a large number 

of documents are defined, the category is quite helpful in organizing the documents into 

meaningful groups. The Explorer organizes the documents you have created by this field. A 

table that contains all of the existing explorer categories supports this field. You can use the 

table or enter a new category name. 

Category The category into which the form document is to be placed. The form document can then be 

found under that category in the Categories pane of the Organizer desktop and in Category 

Documents within a record. This category can also be used to secure documents. A table that 

contains all of the existing categories for the current module supports this field. You can only 

select a valid entry from the table. 

Form Name The name of the form template to be used for this form document. A form popup supports 

this field. 

Optimize for 

PDF Image 

A check box that allows the user to change the image background for a form from high 

resolution EMF to a JPG. This is due to the fact that the high resolution EMF files (which are 

used for form backgrounds) can sometimes have artifacts or areas where the form image does 

not match the original PDF that was attached.   

Note: When producing Forms with background images with the Optimize feature in use, the 

production time will be slightly slower.   

Sort By 1, 2, 3 Three sort fields that determine how the forms are to be sorted. The sorting is performed in 

the order entered. For example, if you wish to sort forms by name within department, enter 

the Department Code field name in the Sort By 1 field and the Full Name field name in the 

Sort By 2 field. The sort order for all three sorts is ascending and cannot be changed. 
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Email Break A check box that allows you to select the “email by break” feature, which enables only forms 

that apply to the email recipient, be sent to that recipient. This field can only be selected if 

the Sort by 1 field is an email type. 

Generating the Form 

After the form document has been created using a form and specifying the query, you are 

ready to generate the form. Use the Run Document option on the File menu or the Run 

Document button on the Tool Bar to generate the form. A form will be generated for each 

record specified by the query. The form for the first record will be displayed in the Document 

Viewer, such as in the example below.  

 

 

Move among the records using the Record Bar for navigation. All of the output options are 

available, except Output to Spreadsheet.  

If you decide to utilize the Optimize for PDF Image feature, consider the following when 

generating, viewing and printing forms: 

 JPG files do not scale as well as EMF files and text will become fuzzy as the document is 

enlarged.  The documents will be quite readable on the screen at 100% size, but may not be 

clear as you enlarge the document.  This would be true both within the People-Trak viewer 

and within the PDF viewer you are choosing.  

Printing a form with the JPG option will result in a document that is not as crisp or as clear as 

with the EMF option.  The document should be readable, but will be visibly different to the 

trained eye. 

It should also be noted that if a Run Document action is used within a trigger, the form 

specified is going to use the prevailing setting for PDF optimization. Additionally, when 

documents are archived, they are saved in PDF format.  If a form with a PDF background is 

to be archived by the user or automatically archived by the Run Document trigger action, the 
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form may need to be set for PDF optimization (use JPG instead).  Otherwise, you may 

inadvertently archive documents with artifacts which limit their readability documents.  
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This lesson covers the steps required to create a form template, which allows you to easily 

output People-Trak data on any form. It also demonstrates how to create complex custom 

forms for reporting purposes. 

Tutorials 
Create a Form Template: shows how to create a form template by selecting the PDF form 

to use and the fields to be included on the form.  

Using Preview Mode: demonstrates how to move some of the objects you have placed on the 

form template. 

Object Properties: demonstrates how to make changes to the location and size of objects on 

a form template by using the Object Properties screen. 

Produce a Form Document: shows how to produce a form document that uses the form 

template and a query you specify. 

Create a Form Template 2: demonstrates how to create a complex custom form for 

reporting purposes.  

Create a Form Template 3: reviews how to create a form template by selecting the PDF 

form to use and placing fields to be included on the form. 

Create a Form Template 4: shows how to create a form template by selecting an edited 

PDF form to use and the fields to be included on the form. 
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Tutorial 1.1 – Create a Form Template  

A form document allows you to easily output People-Trak data on any form you desire. The 

first step in preparing a form document is to create the form template on which it is based. 

Let’s get started. 

1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop 

(or as instructed).  

 

The Select Product Option screen is displayed.  

2. The Position Control and Attendance options should be the only options that are 

toggled on. If not select the Training button to select them. 

3. Click OK 

 

The Login screen is displayed. 

4. In the User ID field, enter DEMO. 

5. In the Password field, enter DEMO. 

 

The Organizer desktop is displayed with the Personnel Management module selected.  

6. On the Templates menu, select Form Templates.  

 

The Form Templates screen is displayed. 

7. On the File menu, select New Form Template or on the Tool Bar, click the New Form 

Template button to start a new form template.  

 

A default name will be assigned. The name is NEW-#, where “#” is the next available, 

unused number 

8. In the Form Name field, enter Emergency Contact Form.  

9. In the Category field, select the Personal category. 

10. Leave the Paper Size field set to Letter because that is the correct size of our form. 

 

The Page Width and Page Height fields are informational and show those dimensions in 

inches. 

11. For this tutorial, leave the Print Form check box selected so the background form will be 

printed. Our form takes up the entire page, so we need to make sure the margin boundary 

is set to 0. 

12. In the Margins field, click the popup. 

 

As you can see, you can select a margin from 0 to 1 inch in ¼ increments.  

13. Select 0.  

Now, let’s select the PDF form we want to use.  
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14. Click the Select Form button to start the process. 

 

The Select File screen is displayed. Only PDF files will be shown as you browse. 

15. In the PT9\ SAMPLES directory of your local People-Trak drive, select the file named 

EMERGENCY CONTACT FORM.PDF.  
 

The Print Form field enables a powerful feature within People-Trak. You need to select a 

background form, as we have, to allow you to align fields on the form. However, it is not 

necessary to actually print the background form when the form is produced. For example, 

if you create a form for payroll checks, you use a generic background form to align the 

fields. When the checks are actually produced, you place pre-printed forms in the printer 

and do not print the background form itself. If you are not using pre-printed forms, you 

place blank paper in the printer and print both the data and the background form. 

16. Click the Preview button and take a look at the form so far, noting the format and the 

fields that need to be filled in. 

17. Close preview mode and return to the Form Templates screen. We will revisit preview 

mode once we have some objects to manipulate. 

 

The Objects grid is where the fields that are to be placed on the form are selected. You 

can select as many fields as you need. You can use row and field modifiers as necessary 

to select the specific fields you need. 

18. In the Object Type column on the first blank row in the grid, select the popup button to 

display a list of the valid object types.  

 

As you can see, there are several object types that we can use for a form template. The 

template we are currently working on will be using field objects. We will take a look at 

other object types in a future lesson. 

19. Select the Field object. 

20. In the Object Name column, click the popup button to display a list of the fields in the 

Personnel Management module. Select the Full Name field.  

 

The Caption column is automatically set to the caption currently associated with this 

field. (In the case of the Full Name field, the caption is set to Full Name.) This can be 

changed, if desired, but we have no need to make a change at this time, so just leave the 

field as is. 

 

The Left and Top fields are set to -1 to let the system know that these coordinates need to 

be calculated. This calculation will happen when first going into preview mode or when 

saving. The Width and Height fields contain the width and height of the field in pixels. 

We’ll learn more about these attributes later.  

To save you some time, here is a list of the rest of the fields needed for our form.  

21. For Object Type, select Field and select the following Field Names: 

Address 1 

Address 2 

City 

State 
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Zip Code 

Contact 1 Name 

Contact 1 Relation 

Contact 1Address 1 

Contact 1Address 2 

Contact 1City 

Contact 1State 

Contact 1Zip  

22. Select the Preview button. 

 

The names of the fields you have placed on the form are listed in the Object dropdown. 

The fields themselves are listed down the left side of the form, but that isnt where we 

need them to be. We need to place the field objects into their respective positions on the 

form, which is a task for the next lesson. 

23. Remain in preview mode and continue with the next tutorial. 
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Tutorial 1.2 – Using Preview Mode 

In the previous lesson, we used preview mode to take a peek at what our form template 

looked like. Now we are going to use it to actually move some of the objects you have placed 

on the form template. 

1. Select Preview to view our form template in preview mode if you have not already done 

so. 

 

Let’s start by using the mouse to drag an object. 

2. Click on the Full Name field to activate it. Then click and drag it down to its respective 

place on the PDF form.  

 

When you moved the Full Name field, the caption did not move with it. There is actually 

a way to have the field and its caption move together if you choose. Let’s try it. 

3. First, move the Full Name field back down to where it used to be, lined up with the Full 

Name caption. Click in the empty area off to the right of the Full Name field to deselect 

it. 

4. This time, click on the Full Name field using the right mouse button. 

 

Both the Full Name field and its caption are now highlighted. 

5. Click and drag the Full Name field and its caption so that once again, the field is placed 

in its proper location on the form. 

You will notice that the caption is overlaying the text for that field on the form.  We will 

remove all captions once we have all of our fields further down the road. 

 

Now that the Full Name field has been moved, you can see that we have some work 

ahead of us, moving each field to where it belongs. We can make this process a bit faster 

by moving more than one object at a time. 

 

The trick to dragging multiple objects is to select them all first. Multiple objects are 

selected by clicking on them while holding down the CTRL key. With the Field object 

you can automatically select its caption as we have seen by right clicking on the field. 

This time let’s do the same thing by using the CTRL key with the Name field for our 

emergency contact. 

6. Click on the Name field and then hold down the CTRL key and click on the caption for 

the Name field.  

 

Both the field and the caption are selected. But did you know that this works with 

multiple fields and captions as well? 

7. While still holding down the CTRL key, select the Relation field and its caption.  

8. Now that these fields and captions are selected, move these fields so that the Name field 

and its caption are properly placed on the form. As you can see, the Relation field and 

caption are almost where they should be, but still require a bit of adjusting. 

 

Sometimes, in an operation such as this, the mouse can be difficult to use. It can seem 

impossible to get the objects to move just one pixel and suddenly your normally supple 
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wrist feels like it has a cast on. So, People-Trak provides a “nudge” feature. Nudging 

allows you to use keystrokes to move an object or a collection of objects one pixel at a 

time. Here is how it works. 

9. Select the Relation field and its caption. Now hold down the CTRL key and then press 

the UP ARROW key to nudge the objects up. Now press the DOWN ARROW key to 

nudge the objects down. To move left and right, use the LEFT and RIGHT ARROW 

keys.  

 

You can use this method to move objects into the precise location you desire without 

“wrist lock”. 

10. Now position the rest of the fields. 

11. Close preview mode.  

 

We don’t need the captions on any of our fields because the form itself already has the 

captions on it. All we need to do is clear the captions for all our fields. 

12. For each of the Field objects, clear the Caption field. 

13. Click the Preview button. 

Now the form looks much better. 

14. Close preview mode. 

 

All of the moving tasks that you just performed were recorded in the object’s property 

settings. In a future lesson we will take a look at how to see these properties for each 

object on the custom screen. But before we do that, let’s see what our form template 

looks like as a form document. 

15. Continue with the next tutorial. 
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Tutorial 1.3 – Produce a Form Document 

Now that we have our form template created, we are ready to produce the output form. 

1. On the Documents menu, select Forms. 

2. On the Tool Bar, click the New Form button to create a new document.  

 

The Forms screen is displayed. 

3. In the Document Name field, enter Emergency Contact Form and place the document 

in any desired Explorer Category. Set the Category field to Personal. 

4. In the Form Name field, click the popup button to display a list of the available form 

templates. Select Emergency Contact Form. 

5. On the Tool Bar, click the Run Form button to run this form. 

 

Since a query was not specified, an Emergency Contact Form is generated for each 

employee, and the form for the first employee is displayed in the Document Viewer. You 

can move between the records using techniques you have learned before. 

6. Close the Document Viewer and the Forms screen, saving your changes. 

7. Close the Explorer. 

 

Output forms can also be produced when editing records just like letters and other 

documents.  

8. Open Donald Stern’s record and remain on the Personal screen. 

9. On the Category Bar, click the Category Documents button. 

 

The Documents for Personal Category screen is displayed. 

The Select Group is defaulted to Current Record, so all we need to do is select our form. 

10. Click on the Document Type column header to sort the documents by type. Within the 

forms that show up, select the Emergency Contacts Form we just created. 

11. Click the Run button to run the form for the current record. 

 

The form will be produced for Donald Stern and displayed in the Document Viewer. We 

could have just as easily selected Use Group and produced a form for each employee in 

the group. 

12. Close the Document Viewer.  

13. Close the Documents for Personal Category screen. 

14. Close Donald Stern’s record. 

15. Continue with the next tutorial. 
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Tutorial 1.4 – Create a Form Template 2 

You have seen how to create a form template based on a form image. You can also create a 

form template for reporting purposes. These form templates may or may not use a form 

image. In our example, we are going to create a form template that includes employee skills. 

1. On the Templates menu, select Form Templates and create a new form template. 

2. In the Form Name field, enter Employee Skills and select Training/Competency for 

the Category field. 

3. Leave the Paper Size field set to Letter. 

4. In the Margins field, enter 0.25, which will create a ¼ margin around the whole form.  

Let’s start adding objects to our form template. The Border object allows you to create a 

nice heading and border for your form template. Let’s add one to our form template. 

5. In the Object Type column on the first blank row in the grid, select the popup button to 

display a list of the valid object types.  

6. Select a Border for the first object. 

 

The Caption defaults to the name of your form but can be overridden, if you choose. 

 

Now, let’s add a frame and fields for the employee information. 

7. Add a Frame object with a Caption of Employee Information. 

8. Add the Employee ID and Full Name fields below that. 

 

Next, we will add the skills grid. 

9. Add a Grid object and use the popup in the Object Name column to select the Skills 

Grid.  

10. Click Preview to take a look at our form template. 

 

We definitely need to do some rearranging and resizing before using our template in a 

form. First of all, the Skills grid is too narrow. Let’s increase its width to fit within our 

form borders. 

11. Either select Grid –Skills Grid in the Object dropdown or click on the Skills grid to 

activate it.  

Now move the cursor to the right edge of the grid. When the cursor crosses the right 

edge, it will change to a left/right arrow. With the left/right arrow displayed, hold down 

the mouse button and carefully drag the right edge of the grid to the right. We do not 

want to move the grid; we want to make the grid wider. 

12. Increase the width of the grid until it fits just within the borders of the form template. 

Chances are that the column headers on the grid may need to be resized after our last 

adjustment. 



Form Templates 

 

 Form Templates     19 
 

13. Click in the header area of the Comment column of the grid, which will highlight that 

header. Hover over the column separator line between that column and the Acquisition 

Date column. The cursor will change to a left/right arrow. Click and hold the mouse 

button down and drag the column to the right until the Acquisition Date column has 

expanded to a size that accommodates the heading text.  

14. Reselect the whole grid and move it down the form so that it is placed directly under the 

frame object that includes the Employee ID and Full Name fields.  

 

You may have noticed when moving the grid, it stayed within the margins set by the 

border. Let’s take a closer look at this.  

15. Select the Skills grid for activation. With your mouse, move the grid a bit past the right 

border of the form template and release it.  

 

Immediately, the Enrollment grid is “snapped” back into the margins set by the form 

border. Within form templates, there is a snap to edge feature that aligns objects to the 

left and right margins. 

Our last grid modification will be decreasing the number of rows within Object 

Properties. 

16. Select the Skills grid and press the F1 key to display the Object Properties screen. 

 

Take a look at the Height field and note the number of rows that our grid has. 

17. Change the Height to 10 and click Apply to apply the change. Click anywhere off the 

grid to be able to see it again. 

Our grid is a smaller size and is exactly how we want it for our form. Let’s take a look at 

how changing the properties of a field object are just as easy as changing grid object 

properties. 

18. Select the Full Name field and press the F1 key to display the Field Object Properties 

screen.  

19. Record the value of the Top field and close Field Object Properties. 

20. Use your mouse to drag the Full Name field towards the top of the form.  

21. Press the F1 key to display the Field Object Properties screen again. 

 

Note that the value of the Top field has been updated to reflect the movement of the 

object. To restore the field to its original place, simply update the coordinate back to the 

value you recorded.  

22. In the Top field, enter the number you recorded. Click the Apply button to apply the 

change. Make any necessary adjustments to move it back into place. 

23. Close Preview mode and the Form Templates screen, saving your changes. 

24. On the Documents menu, select Forms. On the Tool Bar, click the New Form button to 

create a new document. 
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25. In the Document Name field, enter Employee Skills and place the document in any 

desired Explorer Category. Set the Category to Training/Competency 

26. In the Form Name field, click the popup button to display a list of the available form 

templates. Select the Employee Skills template. 

27. On the Tool Bar, click the Run Form button to run this form. 

 

You can see how easy it is to create and edit a very complex form with any information 

available in People-Trak.  

28. Close the Forms screen, without saving your changes. 

29. Continue with the next tutorial. 
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Tutorial 1.5 – Create a Form Template 3 

Now that we have learned about the many features used to create and edit form templates, we 

can put our skills to use while building a form template that uses a complex background form 

with multiple fields that need to be populated. 

1. Using what you have learned in prior lessons, create a new form template. 

2. In the Form Name field, enter Application for Employment. 

3. In the Category field, select the Personal category. 

4. Leave the Paper Size field set to Letter and the Print Form check box selected. 

5. In the Margins field, enter 0. 

6. Click the Select Form button to display the Select File screen. 

7. In the PT9\SAMPLES directory of your local People-Trak drive, select the file named 

APPLICANT INFORMATION 2.PDF 
 

To save time, we will start you off with the first three field objects that need to be added 

to the Objects grid. 

8. For Object Type, select Field and select the following Field Names: 

 

Former Employer 

Employment Start Date 

Employment End Date 

9. Click the Preview button. 

10.  Using what you have learned in prior lessons, move the field objects into their respective 

places on the form. 

 

 As you can see, there are more field objects that need to be added to the Object grid, not 

to mention all of the moving around and resizing that will need to be done. We have 

some tedious and time consuming work ahead!  

 

Let us spare you the extra work as we move on to the next tutorial, which will provide an 

alternative to the drag and drop process. 

11. Close preview mode without saving and continue with the next tutorial. 
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Tutorial 1.6 – Create a Form Template 4 

As we just witnessed, dragging and dropping multiple objects can get a bit out of control. In 

this lesson, you will see how using a PDF form that has been edited to accommodate People-

Trak fields makes creating a form template that much easier. 

1. Using what you have learned in prior lessons, create a new form template and name it 

New Application for Employment. 

2. In the Category field, select the Personal category.  

3. Leave the Paper Size field set to Letter and the Print Form check box selected. 

4. In the Margins field, enter 0.  

5. Click the Select Form button to display the Select File screen. 

 

In the PT9\SAMPLES directory of your local People-Trak drive, select the file named 

APPLICANT INFORMATION 2 EDIT.PDF 

6. Click the Preview button and take a look at the form so far. 

 

Does this form look familiar to you? It should. As you can see, the form we used in the 

last tutorial has been edited in such a way that the Previous Employment fields are now 

one large blank area. We will use this to our advantage. 

7. Close Preview mode. 

8. Add a Grid object and use the popup in the Field Name column to select the 

Employment History grid.  

 

The fields in that grid are automatically filled in on the rows below.  

9. Click the Preview button. 

10. If the Employment History grid is not already selected, select it for activation and move 

and position the grid so that it fits within the available blank space of the Previous 

Employment area. 

Voila! We saved a bunch of time by not moving around fields and captions and our form 

looks pretty good with the grid we added. Now to see what our masterpiece looks like 

when it is run as a form. 

11. Close Preview mode, saving your changes. 

12. Close the Form Templates screen, saving your changes. 

13. On the Documents menu, select Forms. 

14. On the Tool Bar, click the New Form button to create a new document.  

 

The Forms screen is displayed.  

15. In the Document Name field, enter New Application and place the document in any 

desired Explorer Category. Leave the Category field set to User. 
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16. In the Form Name field, click the popup button to display a list of the available form 

templates and select the New Application for Employment form. 

17. On the Tool Bar, click the Run Form button to run this form. 

18. Close the Forms screen, without saving your changes. 

19. Exit People-Trak. 

20. This concludes this tutorial and lesson. 

 

 

 


